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Information:  Excel Geography
Excel has a geography:
TABS are at the very top
Each tab brings up a different menu RIBBON

At the very bottom are SHEET TABS
They navigate you to different work areas called SHEETS or WORKSHEETS

Locations on the worksheets are organized into CELLS 
identified by a lettered column and a numbered row
Click on the cell in the "B" column on the 2nd row
This is now your "ACTIVE CELL"
The NAME BOX show which cell you are in according to these naming conventions
	Notice it says" "B2"
Type your name in this cell and click "Enter"
NOTE: If you have a long name, you don't have to use two cells; Excell lets you spill 
over the edge of the cell
	NOTE: Excel doesn't know it's there until you click "Enter"
	Click back on the B2 cell
The FORMULA BAR is the large area after the symbol:  fx
	Notice it says your name in the formula bar

Answer the questions in the worksheet:
	Which cell is “#” in?
	Which cell is “$” in?
	Which cell is “&” in?
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FORMATTING CELL CONTENTS
You can do things in Excel to make your spreadsheet look "purty"
Highlight cell B15 with yellow
Type in "x"
Change it to BOLD and ITALIC and UNDERLINED
[image: ]Center the contents
Change to letters to red



[image: ]
Move to cell B17
Enter the number "5"
Change it to $
Change it to NO DECIMALS
	(you'll need to click it 
twice)
Outline it with a bold frame

MOVING CELL CONTENTS
Go to cell E4 and enter the symbol "1"
(Don't forget to click "Enter")
Go back to E4
Notice that when you are on a cell, it has a dark FRAME around the cell
The frame is used to copy and move cell contents
To move the cell contents, click on any part of the frame EXCEPT the bottom right corner 
(the bottom right corner is the copy HOTSPOT)
When your mouse is positioned to move cell contents, the cursor shape changes 
	from           to
Move the E4 contents to G5

Tah-dah!
Did it work? If not, yell for help!
Moving cell contents can be done to any other cell in the same worksheet

COPYING CELL CONTENTS
You can copy this cell to following cells using the bottom right corner hotspot
When your mouse is positioned to copy cell contents, the cursor shape changes 
	from           to
Copy the G4 contents by dragging the marker down through G10

Tah-dah!
Did it work? If not, yell for help!

Excel tries to make our lives easier when entering data
	(sometimes they make it harder…)

Go to H4 and enter the number "1"
Copy this number from H4 through H100
(notice you would not want to do this by hand…)
You might have gotten 97 1s… or you might have gotten the count up through 97
	(it depends on which version of Excel you are using)
If your version of Excel gave you 100 1s (but you really wanted the count up to 97) 
	Go to I4 and enter "1"
Go to I5 and enter "2"
	Now copy the contents of I5 through I97
	That should work! If not, yell for help!
If your version of Excel gave you the numbers 1-91 (but you really wanted 100 1s)
	Go to I4 and enter "1"
	Copy the contents down through I97 while holding down the "Ctrl" key
	That should work! If not, yell for help!
This is especially helpful if the "1" is a count as part of a name
	Go to J4 and type in "Subject 1"
	Copy it down through J97
	Look at all the typing you save entering these names!
Copying cell contents can be done vertically (up or down) or horizontally 
(to the right or left)
You can't copy both directions at once - you have to copy one way, then 
copy the other way
Go to K4 and type in "Day 1"
	Copy it down through K15
Copy it to the right through O4 

ENTERING DATA
Excel was designed to do algebra
Numbers and formulas are easy to enter

In arithmetic, every calculation is specific - it only uses certain values:	
2 + 7 – 5 * 463.08
What if you are going to have to do the calculation a bunch of times but with different values 
for the final multiplier? 	    2 + 7 – 5 * 463.08
2 + 7 – 5 * 916.32
We stick in a placeholder for the value that is going to change – called a “variable”
2 + 7 – 5 * x
Now our calculation is called ALGEBRA not ARITHMETIC!
The advantage is that you can stick any value into the formula in the spot held by the 
variable placeholder and the formula will work!
Enter this formula in cell B20: 
=2+7-5*463.08
NOTE: 
all Excel formulas have to start with "="
Notice the formula shows up in the formula bar, too!
In Excel, the "x" is replaced by whorksheet cells and the formula REFERENCES these cells
Enter 463.08 in cell A20
Change your formula in B20 to reference the cell A20:
=2+7-5*A20
Note: you can just click on the cell you are referencing and Excel will put the right cell in the formula


Because you might be looking at this worksheet next week/next year
ALWAYS LABEL YOUR DATA
Note: in this class, if you do not label your data, you lose points!
In cell A19, Type in "Value"
Make it bold, put a double line below it and center it
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In cell B19, Type in "Formula"
Copy the formatting in cell A19 by clicking on A19, clicking the paintbrush, then clicking cell 
B19
Remember, we want to have different input values for the "x" in our formula
Enter "916.32" in cell A21
Enter "-43.2" in cell A22
Enter "6" in cell A23
Copy (remember the corner hotspot?) the formula in cell B20 down through B24

POOF! 
Excel Instantaneously calculates the formula using each of these values
Click on B23 and notice that Excel counted adjusted the formula so the input in column A is 
the right one!
We've copied one too many rows, and Excel uses blank data as "0"
But, we can add a different data value: type "72" in A24

POOF!
Again, an instantaneous calculation!

Isn't that better than doing it by hand?
And, when you save your spreadsheet, it becomes a permanent document

Go to the "Salaries" sheet in your workbook and do the exercise

SAVE YOUR SPREADSHEET NOW

Excel Mathematics
by Ted French, About. com Guide 
http://spreadsheets. about. com/od/excelformulas/ss/07excel_formula. htm
Excel formulas allow you to perform calculations on data entered into the spreadsheet. 
You can use an Excel formula for basic number crunching, such as addition or subtraction, as well as more complex calculations such as payroll deductions or averaging a student's test results. 
In addition, if you change the data Excel will automatically recalculate the answer without you having to re-enter the formula. 
[image: http://0.tqn.com/d/spreadsheets/1/0/s/2/-/-/2007_formula2.gif]The following example creates a basic formula. The steps used to create this basic formula are the same ones to follow when writing more complex formulas. The formula will add the numbers 3 + 2. The final formula will look like this:     = E1 + E2
Entering the data
1. Type a 3 in cell E1 and press the ENTER key on the keyboard. 
2. Type a 2 in cell E2 and press the ENTER key on the keyboard. 
When creating formulas in Microsoft Excel, you ALWAYS start by typing the equal sign. You type it in the cell where you want the answer to appear. 
3. Click on cell E3 (outlined in black in the image) with your mouse pointer. 
4. Type the equal sign ( = ) in cell E3. 
Following the equal sign, we add in the cell references of the cells containing our data. 
By using the cell references of our data in the formula, the formula will automatically update the answer if the data in cells E1 and E2 changes. 
The best way of adding cell references is by using the Excel feature called pointing. Pointing allows you to click with your mouse on the cell containing your data to add its cell reference to the formula. 
[image: http://0.tqn.com/d/spreadsheets/1/0/u/2/-/-/2007_formula4.gif]After the equal sign added in step 2
  5. Click on cell E1 with the mouse pointer to enter the cell reference into the formula. 
  6. Type a plus ( + ) sign. 
  7. Click on cell E2 with the mouse pointer to enter the cell reference into the formula. 
  8. Press the ENTER key on the keyboard. 
  9. The answer 5 should appear in cell E3. 
10. Click on cell E3. The formula = E1 + E2 is shown in the formula bar above the worksheet. 


Mathematical Operators
[image: http://0.tqn.com/d/spreadsheets/1/0/9/-/-/-/screen_cap13.jpg]Creating formulas in Microsoft Excel is not difficult. Just combine the cell references of your data with the correct mathematical operator. 
The mathematical operators used in Excel formulas are similar to the ones used in math class. 
•Subtraction - minus sign ( - ) 
•Addition - plus sign ( + ) 
•Division - forward slash ( / ) 
•Multiplication - asterisk ( * ) 
•Exponentiation - caret ( ^ ) 

Excel Order of Operations
If more than one operator is used in a formula, there is a specific order that Excel will follow to perform these mathematical operations. This order of operations can be changed by adding brackets to the equation. An easy way to remember the order of operations is to use the acronym:  BEDMAS

[image: http://0.tqn.com/d/spreadsheets/1/0/v/2/-/-/2007_formula5.gif]Brackets
Exponents
Division
Multiplication
Addition
Subtraction
How the Order of Operations Works 
Any operation(s) contained in brackets will be carried out first followed by any exponents. 
After that, Excel considers division or multiplication operations to be of equal importance, and carries out these operations in the order they occur left to right in the equation. 
The same goes for the next two operations – addition and subtraction. They are considered equal in the order of operations. Which ever one appears first in an equation, either addition or subtraction, is the operation carried out first. 



Formatting Numbers in Excel
[image: Number formats in an Excel Spreadsheet]Number formatting in spreadsheets, such as Excel, is used to change the appearance of a number or value in a cell in the spreadsheet. 
Formatting numbers does not change the actual number that you enter, but just the way it appears in the spreadsheet. Formatting is done to improve the appearance of the spreadsheet and to make the numbers easier to read and understand. 
Commonly Used Number Formats
Commonly used number formats include adding percent symbols ( % ), commas ( , ), decimal places, and dollar signs( $ ). 
As mentioned, number formatting is attached to the cell and not to the value in the cell. 
For Example - If you select a cell containing a number formatted for currency, the plain number, the one used in calculations, is displayed in the formula bar. 
Number formatting can be applied to a single cell, entire columns or rows, a select range of cells, or the whole worksheet. 
The default format for cells containing a value is the General style. This style has no specific format and displays values as plain numbers – no dollar signs, commas etc. 
Changing Cell Formats
To change a cell's format, you can use one of the buttons on the Formatting toolbar, such as comma, percent or currency which apply preset styles to the selected cells. 
Another option is to use the Format Cells dialog box. The Number tab in the Format Cells dialog box includes the styles on the formatting toolbar as well as other number categories such as time, date, and fraction. 
There are also options for changing the currency symbol displayed to those used in other countries, the number of decimal places shown in a number, and how negative numbers are displayed. 
Special Format Category
There is also a Special category for those special numbers, such as phone numbers, zip codes, and Social Security numbers that are formatted a certain way. Using the drop down box under the Locale option will let you format special numbers appropriate to specific countries. 

A Problem
[image: http://0.tqn.com/d/spreadsheets/1/0/V/-/-/-/cw1.gif]Enter the Chart Data
No matter what type of chart or graph you are creating, the first step in creating an Excel chart is always to enter the data into the worksheet. 
When entering the data, it helps to keep a few simple rules in mind: 
1. Don't leave blank rows and columns when entering your data. 
•If you do leave a blank row, it will make it harder to use the Excel Chart Wizard. While it is possible to include individual rows or columns, it makes creating the chart a bit trickier than if the data is all together. 
2. Enter you data in columns whenever possible. 
[image: http://0.tqn.com/d/spreadsheets/1/0/W/-/-/-/cw2.gif]•When laying out your spreadsheet, list the names describing the data in one column and, to the right of that, the data itself. If there is more than one data series, list them one after the other in columns with the title for each data series at the top. 
Enter the Average Precipitation for World Cities data shown into your spreadsheet. 

Selecting the Chart Data
Click and hold down the left mouse button over one corner cell of your spreadsheet data. 
Drag the mouse pointer over the data to select it. 
Note: Be sure to include any column and row titles that you want to include in the Chart. 
3. Highlight the block of cells from A3 to B12, which includes the column titles, Location and January. 

[image: http://0.tqn.com/d/spreadsheets/1/0/U/-/-/-/cw.gif]Starting the Chart Wizard
You have two choices for starting the Excel Chart Wizard: 
Click on the Chart Wizard icon on the standard toolbar 
[image: http://0.tqn.com/d/spreadsheets/1/0/X/-/-/-/cw3.gif]Choose Insert > Chart. . . from the menu. 
4. Start the Chart Wizard using the method you prefer. 

Pick a Chart on the Standard Tab
Pick a Chart type from the left panel 
Pick a chart sub-type from the right panel 
5. Choose the Column chart type in the left hand pane. 
6. Choose the Clustered Column chart sub-type in the right hand pane. 
7. Click Next. 

[image: http://0.tqn.com/d/spreadsheets/1/0/Q/-/-/-/cw6.gif]Preview your Chart
Having selected your data before starting the Excel Chart Wizard, you should see an example of your chart in the top window of the dialog box. 
On your spreadsheet, the data that has been included in the chart is surrounded by the marching ants -- the animated black border around your data. 
Below the preview window is a box containing the cell references of the data range included in the chart. If your chart doesn't look right, check to make sure you selected the right data range in the spreadsheet. 
  8. Click Next. 
[image: http://0.tqn.com/d/spreadsheets/1/0/R/-/-/-/cw7.gif]Chart Options
Although there are many options under the six tabs for modifying the appearance of your chart in this step, we will only be adding titles to our chart. 
All parts of an Excel chart can be modified after you have completed the Chart Wizard, so it is not necessary to make all of your formatting options right now. 
  9. Click on the titles tab at the top of the dialog box. 
10. In the Chart title box, type the title Average January Temperature. 
11. In the Category (X) axis box, type City Name. 
12. In the Category (Y) axis box, type mm for millimeters. 
13. When the chart in the preview window looks right, click Next. 
Note: As you type the titles, they should be added to the preview window to the right
[image: http://0.tqn.com/d/spreadsheets/1/0/S/-/-/-/cw8.gif]Chart Location
There are only two choices for where you want to place your chart: 
As a new sheet (places the chart on a different sheet from your data in the workbook)
As an object in sheet 1 (places the chart on the same sheet as your data in the workbook)
14. Click the radio button to place the chart as an object in sheet 1. 
15. Click Finish


[image: http://0.tqn.com/d/spreadsheets/1/0/T/-/-/-/cw9.gif]Moving the Chart
Once you have finished with the Excel Chart Wizard, your chart will appear on your worksheet. Most likely it will appear on top of your data, where you probably don't want it. 
To move it:
16. Click on the white background of the chart. 
17. Hold down the left mouse button and move your mouse. 
When you start to move the mouse pointer it will change into a four headed black arrow (indicated with a red arrow in the image above). Drag and drop your chart anywhere on the Excel worksheet. 

Printing your results
Highlight the data box and your beautiful graph. 
Click the “File” tab
Click “Print”
Under “Settings” click “Print Selection”
Click the printer icon 



How to Do Graphs in Excel
Note: your version of Excel will probably look different…

First enter your raw data 
Then create a summary table
Be sure to include your labels!
In the cell below “Clear”, enter:  =sum(
	then click/drag your data into the formula starting with the first data point under 
the raw data “Clear” heading and ending with the last data point in the column 
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TAH-DAH!  The total number of clear beads (without you having to count them)!
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Repeat for the red, white and green data 
Your summary table:
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Highlight all of the summary table (including the labels)
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Click the “Insert” tab - in the middle is “Charts”
Click the “Column”  chart 
Click the top left (boring) style
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TAH-DAH!
A (kinda ugly) graph!
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Because in this case the legend is not adding anything useful, click it and hit “Delete”
This gives more room for the graph
[image: ]























To the right of your graph will be a button with a “+” on it
Click on the “+” (it means “add”) and select “Axis Titles”
Click and POOF! You have titles!
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Click on each and change them to something informative
You can adjust the graph title, too!
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To make your graph even more informative, right click on any of the bars and click 
“Add Data Labels”
[image: ]
Poof! The data can now be seen on your graph!
You can also scroll through “Chart Styles” until you find something you think is purty
Your final graph should look something like:
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Pie Charts in Excel    
To create a pie chart, highlight the summary table (including the labels)
Click the “Insert” tab - in the middle is “Charts”
Click the “Pie”  chart 
Select the style you want
Right click on any of the pie slices and click “Add Data Labels”
Right click any of the data labels
Click “Format Data Labels”
Unclick “Value” and click “Percentage”
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[image: ]
Just like the bar chart, you can make 
it look the way you want!












How to Do a Real IQR and Boxplot in Excel
Note: your version of Excel will probably look different…

You do not need to have the Excel ToolPack installed on your computer for this one…

NOTE:
THE QUARTILE FUNCTION IN EXCEL IS NOT THE SAME AS 
THE CLASSIC DEFINITION OF A QUARTILE
THE VALUE IS  "CLOSE"
FOR THE TRADITIONAL VALUES, CALCULATE INDIVIDUAL MEDIANS FOR THE TWO HALVES OF THE DATA!

First, sort each variable (column in this case) individually
[image: Graphical user interface, table

Description automatically generated]
































You may get an irritating warning
Click "Continue with the current selection    then sort
Poof! Sorted data! 
[image: Table, Excel

Description automatically generated]
















Do this for each of your variables (columns)
[image: Table, Excel

Description automatically generated]





























Create a new table:
[image: Table, Excel

Description automatically generated]















Create the maximums using the formula =max(a5:a34)
[image: Table, Excel

Description automatically generated]















Copy the formula to the rest of the table line:
[image: Graphical user interface, application, table, Excel

Description automatically generated]












Do the same for the minimums using the formula =min(a5:a34)
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And the medians using the formula =median(a5:a34)
[image: A screenshot of a computer

Description automatically generated with medium confidence]











You can copy/paste as values to the duplicate medians line in the second table


The medians fall between two of our data values (because there are 30 values)
Mark them with a different color
[image: Graphical user interface, application, table, Excel

Description automatically generated]




























For Q1, find the median of the first half of each dataset (in this case, A5 to A19)
[image: Graphical user interface, application, table, Excel

Description automatically generated]















Copy that formula to the rest of the table rows
[image: Graphical user interface, application, table, Excel

Description automatically generated]












Q3 will be the median of the second half of each dataset (in this case, A20 to A34)
[image: Table, Excel

Description automatically generated]
































Copy that to the other table rows and you have the REAL 5-number table values!
[image: Table

Description automatically generated]
















Make a high-low-close graph for each table:
[image: A screenshot of a computer

Description automatically generated with medium confidence]
























I am going to designate the Max/Min graph as the "Bottom" (underneath) one
The Q1/Q3 I will designate as the "Top" one
If Q1/Q3 is actually on the bottom in your spreadsheet, right click it and select 
"Bring to Front"

Fixing the Bottom graph for the boxplot:
Click each text item on the Bottom graph and colorize them to blend in with your 
background( mine is black)
Right click the graph lines (if you have any) , select "Format Gridlines"
Click "Line Color" and select "No line"
[image: A screenshot of a computer

Description automatically generated with medium confidence]























Fixing the Top graph for the boxplot:
Right click any of the vertical lines on the Top graph
Click "Format High-Low Lines"
Click "Line Style" and increase the width to make the "box" of the boxplot
Right click on the Top graph and select Format Graph Area
Click "Fill" and select "No fill"
Right click on the graph area (not the lines) and select Format Plot Area
Click on "Fill" and select "No fill"
The Top graph is now almost invisible!
[image: A picture containing graphical user interface

Description automatically generated]





Now we're going to move the Top graph on top of the Bottom graph to make our boxplot
Left click the Bottom graph
Hold down the "Shift" key and left click the Top graph
Both should now be highlighted
At the top of your ribbon you should have an orange bow that says "Drawing Tools"
Click "Format"

[image: Graphical user interface, application, PowerPoint

Description automatically generated]

At the far right of the ribbon click "Align"
Click "Align Left"
Click "Align Top"
Poof!
Your graphs are aligned on top of each other!
And you have something that looks as close to a boxplot as Excel will do
[image: Chart, box and whisker chart

Description automatically generated](yes, it would have been nice if Excel had done all this for us automatically…)


















Doing a Descriptive Statistics Table in Excel
To do this, click the “Data” tab at the top, then “Data Analysis” (on the far right side) 
If “Data Analysis” is not there, you need to install the ToolPack (described later in  this 
sheet)
Click on “Descriptive Statistics” then “OK”
[image: ]Enter the data by clicking on the box at the 
end of the first line “Input Range” 
and then highlighting the data and 
labels on your spreadsheet 
Be sure to include the labels row
Hit enter when you have the area you want
It should now say:  “$A$4:$E$30 
for the “Input Range”
Click the “Labels in first row” box
Click the “Summary Statistics” box and “OK”

Poof!!
You’ve got a whole new sheet in your 
spreadsheet!
(With who-knows-what on it!)
[image: Graphical user interface, text, table

Description automatically generated with medium confidence]













To make it prettier (and easier to understand…), highlight the labels in the first row
[image: Table, Excel

Description automatically generated]













Then grab the edge of the framed area and drag it one column to the right
This aligns the labels with the data in the columns 
(WHO KNOWS WHY EXCEL DIDN’T ALIGN THEM IN THE FIRST PLACE!!!)
[image: Graphical user interface, application, table, Excel

Description automatically generated]
[image: Graphical user interface, application, table, Excel

Description automatically generated]
Now right click on the “C” at the 
top of column “C”
This highlights the column
Hit “Delete”

Poof!
A useless (duplicate)
     	column disappears!
Do this for all the duplicates
	(Leave the initial one in 
column “A”)


[image: Graphical user interface, application, table, Excel

Description automatically generated]It should now look like:




Well, “Yr.Qtr” is the year and quarter
Since it doesn’t make sense to 
calculate the average year 
and quarter in the data, 
delete that column too!
Since Excel is chopping off the
 labels in column “A”, 
double click the line between 
column “A” and column “B” –
this “fits” the column to the 
entries




Today we will be studying “measures of central tendency” (averages)
There are several types of “averages”
Many of these are included in the summary table
[image: Graphical user interface, application, table, Excel

Description automatically generated]
Let’s rearrange the table!
Left click the “4” at the edge of row 4 – 
this highlights the entire row
We don’t want this (this week, at 
least…) so hit “Clear Contents” – 
this clears the row
Left click the “5” at the edge of row 5
Grab the black frame edge and drag 
the row up to row 4

In column “A” of row 5, type
“Midrange”

[image: Graphical user interface, application, table, Excel

Description automatically generated]In column “B” of row 5, enter:
	=(B13+B12)/2
Copy this formula to columns 
“C”, “D” and “E”









We won’t learn about Standard
	Deviation, Sample Variance,
	Kurtosis, or Skewness until 
later classes, so let’s get rid
of them to tidy our table!
Right click (not left this time!) the
	“7” on row 7 and click
“Delete”
[image: Graphical user interface, application, table, Excel

Description automatically generated]

							         This gets rid of Standard Deviation
							         Do the same for Sample Variance,
							               Kurtosis, and Skewness 
Now it should look like: 
[image: Graphical user interface, application, table, Excel

Description automatically generated]
Still, this is not something
	you would want to 
show your boss!

#N/A means “none”
Replace the #N/As










The format is ugly…
Highlight the entire table
On the “Home” tab at
	the top, click the
	comma
[image: Graphical user interface, application, table, Excel

Description automatically generated]



 


















We try to have one more decimal in our answers than appears in the original data
The original data have no decimals, so we should have only one in our answers
To eliminate one decimal, leave the table highlighted and click the “Decrease Decimal” 
button           just once!
[image: Graphical user interface, application, table, Excel

Description automatically generated]






















We still need a title!
Move the Labels row to row 2
In A1 enter: Summary Table for USA Quarterly Cocoa Grind & Bean Equivalent Use 
(BEQ) in tonnes
Now your table tells the whole story (just like a graph should!)
Print your beautiful and informative table and hand it in to the Instructor   (15 points)
[image: Graphical user interface, application, table, Excel

Description automatically generated]

Doing a Multiple Comparison Chart in Excel

Calculate descriptive statistics for each type of bean and measurement  

To do this, click the “Data” tab at the top, then “Data Analysis” (on the far right side) 
If “Data Analysis” is not there, you need to install the ToolPack (described later in  this 
sheet)
[image: ]Click on “Descriptive Statistics” then “OK”
Enter the data by clicking on the box at the 
end of the first line “Input Range” 
and then highlighting the data and 
labels on your spreadsheet 
Be sure to include the labels row
Hit enter when you have the area you want
It should now say:  “$A$4:$E$30 
for the “Input Range”
Click the “Labels in first row” box
Click the “Summary Statistics” box and “OK”

Poof!!
You’ve got a whole new sheet 
in your spreadsheet!
Make it purty by realigning the labels row,
and removing duplicate text columns
It should look similar to this: 
(the numbers may be different because of additional data)
[image: ]

Now we are going to build a second summary table to make a new kind of graph
Copy and paste the labels row to row 18:
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Immediately below the labels, copy and paste the “Maximum” data row:
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Immediately below that, copy and paste the “Minimum” data row:
[image: ]






















And immediately below that, copy and paste the “Mean” data row:
[image: ]
























Note: If your table is not set up like this (no blank rows, 
Max first, then Min, then Avg) the graph won’t work!

Highlight all of this second summary table including the labels  and “Maximum”, 
“Minimum” and “Mean”
Click the Insert tab at the top
Click the icon that looks like a spider web (in old versions of Excel it was called “Other 
Charts”)  click the first Stock Chart (for a “High-Low-Close” chart)
[image: Graphical user interface, application, table, Excel
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Poof!
Ok… so what is it…?

This is a “confidence 
interval” chart
This graph will be 
used A LOT
in this class
The tiny blips in the 
middle of each 
vertical line 
mark the mean
values for 
each bean and
measurement
The line represents 
the range of 
values for each
bean and measurement

Now you can actually answer the question from last week: can we make sieves to sort 
the different types of beans?

[image: A picture containing chart

Description automatically generated]Add an informative Title 
and axis Labels – 
be sure to include the 
units in the vertical

As always, let’s make it purty
Pick colors and a style you like







[image: Chart, box and whisker chart

Description automatically generated]Left click on any of the 
“Mean” points
Click the Paint Can (Fill and 
Line) icon
Click “Marker” 
Click “Marker Options” to 
change to a style 
and color you prefer
(Bizarre factoid: the colors 
won’t change until you change
the size, so change color first,
then adjust the size…)

Note: you can change a single 
marker by couble clicking on it
[image: Graphical user interface

Description automatically generated]

Left click on the top of 
any of the lines 
Click the Paint Can icon
Click “Marker” 
Click “Marker Options” 
Click “Built-in” and select the 
	Marker you want for 
the top of the line 

Do the same for the bottom of the lines

Now it’s looking a little purtier!
[image: Chart, box and whisker chart
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What does it mean?
It means:
	If two lines overlap, the measurements for those beans cannot be separated 
using sieves!




Adding the Analysis ToolPak in Microsoft Office Excel
Start by opening Excel and clicking on the 'Office' button at the top left of the screen. 
At the bottom of the drop down menu, click on the 'Excel Options' button.
The Excel Options window will open. In the column on the left, click on the 'Add-Ins' heading. 
On the right side of the window, scroll down to Inactive Application Add-Ins and click on 'Analysis ToolPak' to select it. 
Then click the 'Go' Button.
An 'Add-Ins' window will open. Click in the checkbox next to 'Analysis ToolPak'
Click the 'OK' button. 
Another window may open that says Excel can’t run the add-in until you install the feature. Click 'Yes'.
The Microsoft Office Configuration window will launch. This can take a minute or two to configure. When it is finished, click on the 'Data' tab and the Analysis group will be on the right side of the ribbon.


For a Mac
Go to “Tools” at the top
Click “Excel Add-Ins

Doing a Multiple Comparison Chart in Excel

Calculate descriptive statistics for each type of bean and measurement  

To do this, click the “Data” tab at the top, then “Data Analysis” (on the far right side) 
If “Data Analysis” is not there, you need to install the ToolPack (described later in  this 
sheet)
[image: ]Click on “Descriptive Statistics” then “OK”
Enter the data by clicking on the box at the 
end of the first line “Input Range” 
and then highlighting the data and 
labels on your spreadsheet 
Be sure to include the labels row
Hit enter when you have the area you want
It should now say:  “$A$4:$E$30 
for the “Input Range”
Click the “Labels in first row” box
Click the “Summary Statistics” box and “OK”

Poof!!
You’ve got a whole new sheet 
in your spreadsheet!
Make it purty by realigning the labels row,
and removing duplicate text columns
It should look similar to this: 
(the numbers may be different because of additional data)
[image: ]

Now we are going to build a second summary table to make a new kind of graph
Copy and paste the labels row to row 18:
[image: ]






















Immediately below the labels, copy and paste the “Maximum” data row:
[image: ]




















Immediately below that, copy and paste the “Minimum” data row:
[image: ]






















And immediately below that, copy and paste the “Mean” data row:
[image: ]
























Note: If your table is not set up like this (no blank rows, 
Max first, then Min, then Avg) the graph won’t work!

Highlight all of this second summary table including the labels  and “Maximum”, 
“Minimum” and “Mean”
Click the Insert tab at the top
Click the icon that looks like a spider web (in old versions of Excel it was called “Other 
Charts”)  click the first Stock Chart (for a “High-Low-Close” chart)
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Poof!
Ok… so what is it…?

This is a “confidence 
interval” chart
This graph will be 
used A LOT
in this class
The tiny blips in the 
middle of each 
vertical line 
mark the mean
values for 
each bean and
measurement
The line represents 
the range of 
values for each
bean and measurement

Now you can actually answer the question from last week: can we make sieves to sort 
the different types of beans?

[image: A picture containing chart

Description automatically generated]Add an informative Title 
and axis Labels – 
be sure to include the 
units in the vertical

As always, let’s make it purty
Pick colors and a style you like







[image: Chart, box and whisker chart

Description automatically generated]Left click on any of the 
“Mean” points
Click the Paint Can (Fill and 
Line) icon
Click “Marker” 
Click “Marker Options” to 
change to a style 
and color you prefer
(Bizarre factoid: the colors 
won’t change until you change
the size, so change color first,
then adjust the size…)

Note: you can change a single 
marker by couble clicking on it
[image: Graphical user interface

Description automatically generated]

Left click on the top of 
any of the lines 
Click the Paint Can icon
Click “Marker” 
Click “Marker Options” 
Click “Built-in” and select the 
	Marker you want for 
the top of the line 

Do the same for the bottom of the lines

Now it’s looking a little purtier!
[image: Chart, box and whisker chart
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What does it mean?
It means:
	If two lines overlap, the measurements for those beans cannot be separated 
using sieves!




    Time Series Forecasting with Regression in Excel 

Olympic statistics have been increasing over the years
We want to forecast the Men’s High Jump value for 2016 
and 2020

Go to the “Homework” sheet in your Week05 spreadsheet
Highlight all of the data including labels from “Year” to “Forecast”
	and down through 2020 (where your forecast will be…)





Graph using the Scatter Chart “Scatter with Straight Lines”



Make it purty…
It should look similar to:
[image: Chart, line chart, scatter chart
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Which is still kinda ugly…

Why does it start in 1850? And end in 2050?
AAAGH!!!!



[image: Graphical user interface

Description automatically generated with medium confidence]Let’s fix it…
Right click on the years 
values on the graph
Then click on “Format Axis”


















[image: Graphical user interface

Description automatically generated]Change the 
Minimum to 
“Fixed” with 
the value
1900

Change the 
Maximum to 
“Fixed” with
the value
2020

Click “Close”









Now it looks better! 
[image: Chart, line chart, scatter chart
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We want to make a forecast, so we need a formula!
It kinda looks like a line, so let’s try Regression!
[image: Graphical user interface, application

Description automatically generated]
Our dependent 
variable “y” is 
“High Jump” 

Enter this data 
including the 
label at the top

Our independent 
variable “x” is 
“Year”

Enter this data 
including the 
label at the top
BUT ONLY DOWN
TO 2020 – the end 
of our “y” data

Click the “Labels”
Box 


Click “OK”
Poof! A new sheet with regression-stuff on it!

Change the R Square into percent with two decimals

The R Square for this data is:  __________________________
[image: Graphical user interface, application, table, Excel
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Highlight the four cells with the coefficient values 
and their labels

Right click the highlighted   area
Click “Copy”
Return to the “Homework”          sheet
Right click on the F1 cell
Click “Paste”

Now we’re going to create our 
	Trend line 

Click on cell C5
Enter:  =G$2*A5+G$1
If you did it right, the coefficient values
	will be highlighted as well as the 
year value “1900”

Note: we use “G$2” and G$1 because 
the $ will keep the formula fixed on 
these coefficient cells when we copy 
it down the column

We want the “Year” value to change, so
we don’t use the $ for that cell reference

Copy the formula down to the bottom of the 
“Trend” column INCLUDING 2016 and 2020

	

Again, poof!

Note that because we included the “Trend” column in our original graph, it appears 
instantly in the graph!
(I did this to save you some work… aren’t I nice?)
[image: Graphical user interface, application, table, Excel
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But, it’s showing our 2016 and 2020 values as “Trend” rather than “Forecast” values

An easy fix!

Highlight the last two values (our forecast) and DRAG them (don’t copy!) sideways to 
the forecast column 



Again, POOF!
A forecast on our graph !
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You have a choice here…
This forecast is detached from our trend line
You can also copy/paste values the 2012 value to the forecast column
This attaches the forecast line to the trend line, but it also changes the color for 2012 to 
the “Forecast” color…
~sigh~
Gotta Luv Excel!

Do whichever you prefer!



Are the forecasts likely to be accurate? Why or why not?
[image: Chart, histogram
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How to fit a curve:
While many graphs look exponential, the easiest way to fit a curve is by using a square
If the curve doesn't have a long flat "tail" to the left, the square will usually work fine
Add a new column (say column "B" next to your date column (say column "A")
Enter an equation:  =A6^2   (for data starting in row 6)
Copy this to the bottom of your data (including any forecast rows)
[image: Graphical user interface, application

Description automatically generated]Give a title to the column (like Yr^2)
	Do the usual time series regression using 
both your date and your date 
squared columns as the "x" 
variables
	Enter your trendline formula including both 
the date and date squared 
coefficients in your formula

For true exponential or logarithmic data, right click on the data in your graph
Click "Add Trendline
This window appears:
Choose any of the options
Be sure to mark "Display Equation on chart"
The equation will give you a hint of the equation 
you need to add in a modified date
column (similar to the Yr^2 above)
NOTE: these equations are rarely the "best" fit. Mess around with the equation until you get what you want.


How to Calculate Correlations in Excel

Your data will consist of values for two or more variables
People say women’s skirt lengths are related to the sunspot number
Maybe so… but I can’t find any real data on women’s skirt lengths…
Let’s investigate some other variables related to weather, economics, human behavior and 
space weather
[image: Table, Excel
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You want to know how the different variables relate to each other, and if they relate to 
sunspots
You don’t really care about the year… so we’ll leave it out of the analysis

Go to “Data”  “Data Analysis”  “Correlation”
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[image: Graphical user interface, application

Description automatically generated]Input your data rectangle including 
the labels (critically important 
for this analysis!)
BUT leaving our the “Year” 
column (not a disaster if you 
leave it in…)

Mark that you have labels in the 
first column

Click “OK”
Poof! Another new sheet!
[image: A screenshot of a computer
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But… what does it mean?
This matrix (rectangle of numbers) is important in that is shows which variables are positively 
related and which are negatively related
For example, sunspots are positively related to the Aurora (Northern and Southern Lights) 
seen on Earth, and electromagnetic storms. That makes sense because both of these 
are related to weather on the Sun, as are sunspots 
All the other variables are negatively related. That would mean, as the number of sunspots 
goes up, the other variable’s value go down.
Raw correlation values are difficult to interpret. The simple lists seen in textbooks ignore that 
some fields (like physics) can have very high correlations while other fields (like 
climatology) rarely get more than moderate correlation coefficients.
[image: Table

Description automatically generated]Let’s change our r-values into 
RSQ (R2) values, which 
can be interpreted as 
percentages
Copy down the horizontal and 
vertical labels:






[image: Graphical user interface, application, table, Excel

Description automatically generated]Enter the formula into the top 
left cell that will square 
the correlation coefficient:

=B2^2
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Description automatically generated]Copy the formula down and 
	sideways to duplicate
	the pattern in the first
	matrix:
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Tah-dah!
















Make the second matrix percentages with 2 decimal places:
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I like to colorize the larger ones in my tables (you get to determine which are “large”)
I check back on the first table whether each of the larger RSQs was positive (colorized green) or negative (colorized orange) (again, you get to use your choice of colors)
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We can see the largest correlations with sunspots are the two space weather variables, and 
the number of Aurora correlates VERY highly with the number of electromagnetic 
storms (the highest correlation in the table.)
But, irrespective of sunspots, we can see the largest non-solar relationship in the table is 
that a high number of tornadoes correlates with a high number of Canadian 
immigrants – that’s GOT to be a coincidence… immigrants don’t CAUSE tornadoes, 
and a lot of tornadoes would probably drive immigrants away!
Another high correlation is that when there is a good wheat harvest, there are a lot of cattle. 
Both rely on weather, so that makes sense. And cattle eat grain (corn, usually, not 
wheat, but these probably relate highly due to weather.)
Cattle and wheat are both negatively correlated with tornados, which also makes sense: 
crummy weather spawning tornados would probably be bad for crops and livestock.



How to Do a Regression Analysis in Excel

Frequently a dependent variable “depends” on one or more other (independent) variables
The equations relating the dependent variable values to its independent variable values is 
[image: Graphical user interface, application, table, Excel

Description automatically generated]called a regression equation
In this example, we’re trying to find 
if there is a relationship 
	between attending 
class and your final 
grade in the class

Always start with a graph!	

Make a scatter chart of all or your 
data – be sure to include 
the labels
Use the “dots” version
Fill in the Title and add Axis Titles
Make it purty

[image: Chart, scatter chart
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Go to “Data”  “Data Analysis”  “Regression”
Use your dependent variable for “Input Y Range” 
Include the label
Use the independent variable for “Input X Range”
[image: Graphical user interface, application

Description automatically generated]Include the label
Mark that you are using Labels
Click “OK” 	
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Description automatically generated]Poof! A new page!
















Change the RSQ to a percent with 2 decimal places
The formula for the regression equation uses the coefficients:
Final Grade = 0.28 + 0.68  Attendance
These coefficients will allow you to make a regression equation to estimate expected grade 
based on attendance


Enter the formula in the "Model" column (don't forget the $): 
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Copy down to the bottom of the dataset
Poof! Instantaneous model values on the graph! 
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You can change the dots into a line if you like
[image: Chart, scatter chart
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Demand Models in Excel

[image: Table, Excel

Description automatically generated]You can have as many independent variables 
as you want in Excel
(You can only have one “y”)
Because there are many “x” variables, this is a 
“multiple” regression 
Demand models are a common use of multiple 
regression
Demand for an item commodity is determined 
by the price of the item, the income of the 
consumers, consumer tastes and 
preferences, prices of related goods, and
the expectation the consumer has of 
future supply and price
Graphs of the original data are typically confusing 
and not-beautiful
So… for once I’m not recommending doing a 
graph first!
(we’ll do one later…)

First do a correlation:
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This table shows the strength and direction of the relationship between demand and price and future supply:	As the price increases, demand decreases
As the desirability decreases, demand decreases

[image: Graphical user interface, application

Description automatically generated]Next do a regression analysis 
Use "Demand" for the dependent 
"y" variable 
Use "Price" and “Desirability” for 
the independent "x" 	variables
Change your R2 to % with 2 decimals see 
if your model is likely to be doing a 
"good" job
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[image: Table

Description automatically generated]Create "Model" data using 
the regression coefficients 





















[image: Chart, line chart

Description automatically generated]Create a scatter graph for 
ONLY the Demand and 
Model columns
Use the “dots” version of the 
graph 
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Description automatically generated]Right click any datapoint
Click "Add Trendline“
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Description automatically generated]Click "Linear" 

"Close"


























Poof! A trendline!
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A “good” model will have values “near” a 1:1 line 
So lets' add one to our graph!
Click “Insert” “Shapes” and choose the line without the arrow
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If the trendline is “close” to the 1:1 line, the model is “good”
[image: Chart, line chart
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How to Graph Confidence Intervals  in Excel
Note: your version of Excel will probably look different…

(You will need to have the Excel ToolPack installed on your computer

Calculate a confidence interval for each temperature location 
To do this, click the “Data” tab at the top, then “Data Analysis” (on the far right side) 
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Click on “Descriptive Statistics” then “OK”
[image: Graphical user interface, application, table, Excel

Description automatically generated]
Enter the data by clicking on the box at the 
[image: ]end of the first line “Input Range” 
and then highlighting the data and 
labels on your spreadsheet 
Be sure to include the labels row
     (my range says: $A$4:$D$25)
Hit enter 
Click the “Labels in first row” box
Click the “Summary Statistics” box and “OK”







Poof!!
You’ve got a whole new sheet in your spreadsheet!
With who-knows-what on it!
To make it prettier (and easier to understand…), highlight the labels in the first row
Then grab the edge of the framed area and drag it one column to the right
This aligns the labels with the data in the columns 
(WHO KNOWS WHY EXCEL DIDN’T ALIGN THEM IN THE FIRST PLACE!!!)
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[image: Graphical user interface, application, table, Excel

Description automatically generated]Now right click on the “C” at the 
top of column “C”
This highlights the column
And brings up a menu
Hit “Delete”





Poof!
A useless (duplicate)
     	column disappears!
Do this for all the duplicates
	(Leave the initial one in 
column “A”)
Since Excel is chopping off the labels in column “A”, 
double click the line between column “A”
and column “B”–this “fits” the column to 
the entries
It should now look like:
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Excel has a sneaky/wonderful way to graph Confidence Intervals!
This graph is a little like the box plot, but much easier to understand!
How to do it:
Copy the labels to columns I-M
Create a new label “Upper 95% CI” in cell H2
Create a new label “Lower 95% CI” in cell H3
Copy the “Mean” row (A3-F3) to H4-M4
[image: Graphical user interface, application, table, Excel

Description automatically generated]It should now look like:
















Type the formula “=I4+2*B4” in cell I2 (this is the formula for the upper 95% confidence 
interval value)
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Description automatically generated]Copy the formula to the other cells in this row:
















Now for the lower values!
Type the formula “=I4-2*B4” in cell I3 
Copy this formula to the other cells in the row:
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Highlight this new table (including all of the labels)
Click on the “INSERT” tab at the top
Go to the “Charts” section
Click on the icon that looks like a spider web 
Click on the first graph under “Stock”
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Poof!
But… what IS this???
[image: Graphical user interface, application, table, Excel
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This is called a “Hi-Lo-Close” graph
We’ll be using (misusing?) it to graph confidence intervals!
Remember, I want labels on graphs – they should tell the whole story without 
explanatory text
Click the “+” sign to the right of the graph
Click “Axis Titles” (and “Chart Title” if it’s not already marked)
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Poof! Now there is a place to enter titles for the chart and axes
Enter your descriptive titles – be sure to include the units for temperature!
[image: Chart

Description automatically generated]





















OK, now it’s informative (sort-of), but it’s still UGLY! And hard to see what’s going on!
Right click the top of any one of the vertical lines in the graph
They all become highlighted
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Click on the paint can






Click on “Marker”
Click on “Marker Options”
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Click on “Built-in”
Select a marker for the top of the lines – this will mark the top value in the confidence 
interval
You can select a different color for this marker by clicking “Fill” under “Marker Options”
Do the same for the bottom of the lines to mark the bottom value in the confidence 
interval
Right click the almost invisible marker for a mean in the center of the lines
Change the marker or make it bigger
Now your graph shows the means (the central markers) and the range of the confidence 
[image: Chart, scatter chart

Description automatically generated]intervals for each of the temperature locations


But… it’s all squashed up to the top (I’m never satisfied…!)
Right click the numbers on the vertical axis
Under “Axis Options”
	change the minimum value to “80”
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Notice the graph is easier to see now!
When the graph is clicked, a green box hovers at the top
Click “Design” to see some prefab graph designs to make your graph “purty”
Or add your own design touches to make your graph YOUR graph!
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OK. It’s purty… but what does it mean?

Remember, if a value is beyond the range of the confidence interval, we are 95% certain it’s not the true population value.

We’re trying to see if the IR thermometer can measure human temperature accurately.
Does the IR thermometer measure 98.6 for any of the body locations?


Can you say with 95% confidence that an IR thermometer can be used to 
       accurately measure human temperature at 98.6 degrees? Why or why not?


Another delightful feature of graphing a group of confidence intervals is that, like the box plots, if two intervals overlap, we cannot say the two groups are different. If they do not overlap, we can say with 95% certainty that they are different.
“X” which pairs are different, circle the one in each pair that is higher:

Inside mouth/Forehead		Inside mouth/Back of hand	
	
Inside mouth/Palm of hand		Inside mouth/Thumbnail

Forehead/Back of hand		Forehead/Palm of hand

Forehead/Thumbnail		Back of hand/Palm of hand
		
Back of hand/Thumbnail		Palm of hand/Thumbnail
 

t-Tests in Excel

Using the “Brewery Sensory Data” 
Our null hypothesis will be “There is no difference between the mean flavor 
characteristics of the two formulations”
Symbolically, this would be:
 = 

Our alternate hypothesis would be:   
 ≠ 
Click on “Data”
Click on “Data Analysis”
Click on “t-test: Paired Two Sample for Means” 
[image: Graphical user interface, application

Description automatically generated]For Variable 1
   range, enter
   the F5_10 data
   including the 
   label
For Variable 2, 
   do the same for 
   N25_5
For “Hypothesized
   Mean Difference”
   type:   0
Mark “Labels”
What is your 
   α-level?

Click “OK”
Poof! 
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Description automatically generated]A new sheet!


You should see:
P(T<=t) one-tail is used to test whether
   one mean is greater than the other



P(T<=t) two-tail is used to test whether
   one mean is different from the other



Because we had no reason to expect 
   one formulation to be better than the 
   other, we would use the two-tail test
You reject the null hypothesis if 
P <=  α 



How to Do ANOVA in Excel

(You will need to have the Excel ToolPack installed on your computer

Click on “Data”
Click on “Data Analysis”
Select the ANOVA you want from the list (use Anova: Single Factor)

For the input range, highlight the data in columns b-d including the labels (do not 
include the months) 

Mark that you have Labels in First Row
Hit “OK”
Poof! A new page!

What is your p-value?

Just to see better what’s going on, let’s do a Hi/Lo/Close graph
Go back to your data page
Click on “Data”
Click on “Data Analysis”
Select “Descriptive Statistics”
Get the descriptive statistics table “purty”
Create your Hi/Lo/Close table
(If you’ve forgotten how to do this, look at the Doc for Week 10 Class 2)
Create your Hi/Lo/Close graph
Make sure it has all the titles and looks “purty”
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They navigate you to different work areas called SHEETS or WORKSHEETS


 


 


Locations on the worksheets are organized into CELLS 


 


identified by a lettered column and a numbered row


 


Click on the cell in the "B" column on the 


2


nd


 


row


 


This is now your "ACTIVE CELL"


 


The NAME BOX show which cell you are in according to these naming con


ventions


 


 


Notice it says" "B2"


 


Type 


your name


 


in this cell and click "Enter"


 


NOTE: If you have a long name, you don't have to use two cells; Excell lets you spill 


 


over the edge of the cell


 


 


NOTE: 


Excel doesn't know it's there until you click 


"Enter"


 


 


Click back on the B2 cell


 


The FORMULA BAR is the large area after the symbol:  


f


x


 


 


Notice it says 


your name 


in the formula bar


 


 


Answer the questions in the worksheet:


 


 


Which cell is “#” in?


 


 


Which cell is “$” in?


 


 


Which cell is “&” in?
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Course:
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Probability and Statistics
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